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Criando um novo projeto 

 

O Altium Designer pode ser aberto, uma vez devidamente instalado, por meio do menu Iniciar ou de 

atalho na Área de Trabalho. É acessado em:  

Iniciar → Todos os Programas → Altium → Altium Designer Release 10 

A tela inicial do programa é mostrada na Fig. 1: 

 

Figura 1 - Tela inicial do Altium Designer 

Para a confecção de uma PCB um projeto deverá ser criado. O caminho para criação de um projeto é por 

meio do Menu New, como mostra a Fig. 2: 

New → Project → PCB Project

 

Figura 2 - Criando um novo PCB Project 
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Após criar o projeto o mesmo estará vazio e aparecerá uma barra no lado esquerdo semelhante à Fig. 3. 

Será mostrado o nome do projeto e, abaixo, a barra lateral mostrará todos os arquivos que serão 

adicionados. 

 

Figura 3 - Aba de projetos 

Há três tipos principais de arquivos para um projeto: arquivos fonte (.prjPCB), esquemáticos  (.SchDoc) e 

PCB (.PcbDoc). Os arquivos do tipo fonte são os principais e contém informações referentes ao projeto, 

além dos esquemáticos e das placas. Os esquemáticos são onde iremos inserir os componentes e realizar o 

desenho do circuito. Os arquivos PCB serão onde desenharemos as trilhas e finalizaremos o arquivo para 

prototipagem. 

Precisamos agora adicionar um arquivo esquemático e um PCB ao projeto. Para criar o esquemático, 

como mostra a Fig. 4, é usado o seguinte caminho: 

Clique com o botão direito do mouse em PCB_Project1.PrjPCB → Add New to Project → Schematic 

 

Figura 4 - Adicionando um esquemático 

Adicionaremos agora um arquivo com extensão PCB ao projeto. O caminho será, Fig. 5: 

Clique com o botão direito do mouse em PCB_Project1.PrjPCB → Add New to Project →  PCB 

 

Figura 5 - Adicionando um PCB 
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Ambiente de Trabalho 

 

A Fig. 6 mostra a tela inicial do Altium, onde se pode encontrar todos os recursos necessários para a 

execução de um projeto. A Área de Trabalho do Altium apresenta: 

 Botão DXP: menu onde o usuário pode configurar sua conta Altium (usuários cadastrados), fazer 

downloads de plug-ins e atualizações. 

 Barra de Menus: Onde se encontram todos os menus principais e suas funcionalidades. Os 

menus são: 

o File: menu usado pra criar, salvar e imprimir um projeto, importar componentes de 

outro projeto, acessar o histórico do Altium, etc. 

o Edit: menu onde se pode editar componentes, trilhas, selecionar uma área, etc. 

o View: menu usado para mudar as configurações de visualização, ajustar o zoom, 

habilitar/desabilitar a visibilidade das barras, etc.  

o Project: menu usado para configurar projetos, além de cria-los e fechá-los, etc. 

o Place: menu onde podemos encontrar as ferramentas mais usadas. 

o Design: menu que configura e disponibiliza modelos de projetos e bibliotecas de 

dispositivos. 

o Tools: menu que possui outras ferramentas do Altium, além de atalhos para opções 

existentes em outras barras, etc. 

o Simulator: menu usado para simulações e que apresenta banco de ensaios. 

o Reports: menu que lista materiais em geral. 

o Window: menu que controla janelas e abas.  

o Help: menu de ajuda do Altium. 

 Barra de Ferramentas: Menu onde podemos encontrar atalhos de opções existentes na Barra de 

Menu tais como abrir arquivo, salvar, recortar, copiar, colar inserir componente eletrônico, etc. 

 Abas: barra onde são encontradas as abas dos diferentes arquivos do projeto. 

 Barra de Projetos: barra onde é mostrado o projeto que está sendo usado assim como todos os 

arquivos que nele foram adicionados. É possível também criar ou abrir projetos, esquemáticos e 

arquivos PCB, bibliotecas, etc. 

 Área de Trabalho: local reservado para o usuário criar os circuitos e PCB’s desejados. 

 Barra de Status: barra do status do Altium. 

 Barras de Rolagem: barra de rolagem do Altium usada para percorrer todo o projeto de forma 

fácil. 
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Figura 6 - Ambiente de trabalho 
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Esquemático de um projeto  

 

Para desenhar o esquemático do circuito utilizado no projeto é necessário primeiro que haja um arquivo 

do tipo .SchPcb no projeto e seja aberta sua aba na Área de Trabalho. O esquemático já está apto à edição. 

Para inserir algum dispositivo eletrônico será utilizada a opção Place Part da barra de ferramentas, Fig. 7. 

 

Figura 7 - Place Part 

 Criando um novo componente 

Em certos projetos, se faz necessário a criação de um novo componente para a montagem do esquemático 

por não existir nas bibliotecas que o usuário possui. Para se criar um novo componente no Altium, deve 

acessar o seguinte menu: 

File → New → Library → Schematic Library 

A tela da Fig. 8 surgirá: 

 

Figura 8 - Tela inicial de novo componente 

Para se desenhar o componente, utiliza-se o menu Place. Para se criar um CI, por exemplo, utiliza-se os 

atalhos Place Rectangle, Place Pin e Place Text String. Ao se adicionar o Place Pin, deve-se tomar 

cuidado para que a ponta destacada e numerada fique para fora do componente, pois é o local onde se 

realiza as ligações entre os componentes, Fig. 9. 
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Figura 9 - Posição do pino do esquemático 

Para finalizar a criação do componente, acesse o menu: 

Tools → Rename Componentes 

Ao surgir a tela da Fig. 10, renomeie seu componente, depois salve o arquivo com o mesmo nome. 

 

Figura 10 - Rename Component 

Ao final, seu componente “Dip 6” foi criado com sucesso, Fig. 11. 

 

Figura 11 - Componente final 
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 Inserir um componente 

Com o esquemático já criado, pode-se abri-lo por meio da aba “Schematic”. Uma janela semelhante à da 

Fig. 12 aparecerá na tela. 

 

Figura 12- Menu Place Part 

Essa ferramenta do Altium tem os seguintes recursos editáveis: 

 Physical Component: campo onde será especificado o tipo de componente eletrônico a ser 

utilizado.Ex: resistência, diodo, indutor, transistor, CI, etc. 

 Logic Symbol: símbolo lógico do componente. 

 Designator: numeração que diferencia determinado dispositivo e suas configurações dos demais 

do mesmo tipo.  

 Comment: comentário usado para especificar o valor da peça. 

 Footprint: forma física característica do componente em geral e de como será inserido na placa. 

Descreve do tipo de encapsulamento do CI’sao número de pernas de um dispositivo, etc. 

 Part ID: ID de identificação do componente. 

 Library: arquivo onde contem o esquemático e o footprint de divesos componentes do mesmo 

tipo. Tem a extensão “IntLib”. 

 Database Table: tabela database a qual o componente pertence. 

Existem basicamente duas formas de escolher um dispositivo: 

1. Clicar no botão “Choose” da Fig. 12 e escolher o componente desejado. 

2. Especificar detalhadamente o componente nos campos para edição na janela da Fig. 12. 

A opção “History” contem uma lista com os últimos componentes a serem utilizados. Caso o Altium 

esteja sendo utilizado pela primeira vez após a instalação, a opção mostrará uma pasta vazia. Esse botão 

abre a janela “Place Parts History”, Fig. 13. 
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Figura 13 - Placed Parts History 

Ao clicar no botão “Choose” na tela da Fig. 13 aparecerá a janela “BrowseLibraries” mostrada na Fig. 14. 

 

Figura 14 - Browse Libraries 

A janela da Fig. 14 tem como seguintes recursos: 

 LIbraries (Bibliotecas): Item com arquivos onde contem o esquemático e o footprint de diversos 

componentes do mesmo tipo. Tem a extensão “.IntLib”. 

 Mask (Máscara): Componente escolhido. 

 Campo de Seleção: Campo onde será selecionado um componente de determinada biblioteca. 

 Esquemático: Campo onde é mostrado o esquemático do componente selecionado no Campo de 

Seleção. 

 Footprint: Campo onde é mostrado o footprint do componente selecionado no Campo de 

Seleção. 

 Campo de Especificação: Campo onde serão mostradas as especificações do componente 

selecionado no Campo de Seleção. 

Após escolher o componente desejado, basta clicar em “OK”. A janela da Fig. 13 será aberta novamente. 

O campo “Designator” agora terá uma letra relativa ao componente eletrônico selecionado. Ao lado dele 

há uma interrogação. Coloque um número ao lado para diferenciar esses dispositivos de outros que 

possam ser ainda inseridos no circuito. Assim esse dispositivo pode ser referenciado pelo seu 

“Designator”. Após clicar com o botão direito do mouse na área de trabalho de esquemático, o 

dispositivo será inserido no esquemático. Ainda é possível adicionar outro componente idêntico. O 

Altium atualizará automaticamente as referências dos componentes inseridos. Digite “Esc” e a janela será 

aberta novamente e assim o “Designator” do novo dispositivo pode ser alterado. Podem ser inseridos 

inúmeros dispositivos do mesmo tipo.  
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A fonte pode ser inserida por meio do ícone “Vcc Power Port” localizado na barra de ferramentas como 

mostra a Fig. 15: 

 

Figura 15 - Vcc Power Port 

O sinal de aterramento pode ser inserido por meio do ícone “Gnd Power Port” localizado na barra de 

ferramentas no lado esquerdo do ícone “Vcc Power Port”. Ver Fig. 16 

 

Figura 16 - GND Power Port 

Uma vez que os componentes do circuito já foram inseridos no esquemático é necessário interliga-los. Os 

ramos podem ser inserido por meio do ícone “Place Wire” localizado na barra de ferramentas.  A Fig. 17 

mostra o item: 

 

Figura 17 - Place Wire 

Para conectar os componentes, após clicar em “Place Wire”, o curso mudará: ficará semelhante a uma 

cruz. Deve-se clicar em um terminal do componente desejado (um “X” aparecerá no terminal como 

mostra a Fig. 18 e, em seguida, clicar no terminal do outro componente (Fig. 19). Quando a ferramenta 

“Place Wire” é usada de forma correta o Altium cria uma linha que interligar os terminais dos dois 

dispositivos (Fig. 20). 

 

Figura 18 - Interligando componentes no Altium 

 

Figura 19 - Interligando componentes no Altium 
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Figura 20 - Interligando componentes no Altium 

O procedimento para criar os ramos do circuito pode ser repetido indefinidamente. A Fig. 21 apresenta o 

esquemático pronto. O circuito apresentado acende um LED. 

 

Figura 21 - Esquemático pronto 

 Renomear automaticamente os componentes. 

Ao adicionar os componentes do circuito, eles ficam com numeração padrão como os resistores, R?, ou 

diodos, D?, dependendo do que tiver sido configurado no componente. Ao se adicionar muitos 

componentes, perde-se muito tempo para apenas renomear os componentes de modo a identifica-los. 

Assim, para se renomear automaticamente todos os componentes, basta utilizar a opção Force Annotative 

All Schematics que fica no menu Tools do esquemático 
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Exportar para PCB 

 

Para transferir um esquemático pronto e devidamente configurado para a PCB utiliza-se o Menu Design, 

como mostra a Fig. 22. 

Menu Design  →    Update PCB Document PCB1.PcbDoc  →    Execute Changes 

 

Figura 22 - Menu Design 

Essa opção irá passar o circuito desenhado no esquemático para o arquivo PCB1.PCBDoc que foi criado 

no projeto. É recomendado salvar o projeto antes de fazer esse passo. Logo após, será aberta outra janela 

semelhante a apresentada na Fig. 23. 

 

Figura 23 - Engineering Change Order 

Para passar todos os componentes inseridos e todas as ligações feitas do Esquemático para a PCB clica-se 

em “Execute Changes”. Após isso, clique em “Close”. O Altium abrirá automaticamente o arquivo PCB. 

A Área de Trabalho desse arquivo é escura como apresenta a Fig. 31. O esquemático exportado estará no 

canto inferior direito. 
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 Criando um novo footprint 

Para se criar um novo footprint no Altium, deve acessar o seguinte menu: 

File → New → Library → PCB Library 

A tela da Fig. 24 surgirá: 

 

Figura 24 - Tela inicial de novo footprint 

Para se desenhar o footprint, utiliza-se o menu Place. Para se criar o footprint do CI criado anteriormente, 

por exemplo, utiliza-se os atalhos Line e Pad. Ao se criar as linhas de contorno, deve-se selecionar a layer 

“Top Overlay”. Deve-se tomar cuidado para a unidade utilizada para as distâncias, no dimensionamento 

de componentes, é comum utilizar a unidade “mil”. Para se alternar entre “mm” e “mil” basta apertar a 

tecla “Q”.  

Para finalizar a criação do componente, acesse o menu: 

Tools → Componentes Properties 

Ao surgir a tela da Fig. 25, renomeie seu componente, depois salve o arquivo com o mesmo nome. 

 

Figura 25 - PCB Library Component 
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Ao final, o footprint “Dip 6” foi criado com sucesso, Fig. 26. 

 

Figura 26 - Footprint final 

 

 Modificação de Pads 

Os Pads representam o local onde o furo ocorrera, porção em verde, e a área de soldagem, porção cinza. 

Caso se deseje modificar os tamanhos dessas porções, clica-se duas vezes em cima do Pad desejado, a 

tela da Fig. 27 surgirá. 
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Figura 27 - Características do Pad 

No menu Hole Size, define-se o tamanho do furo do Pad e seu formato. 

No menu Size and Shape, define-se o tamanho da área de soldagem do Pad, horizontal e vertical, e o seu 

formato. 

Ao finalizar as edições do Pad clica-se em OK. As alterações serão realizadas apenas no Pad selecionado. 

Caso se deseje modificar todos os Pad com uma característica semelhante (mesmo tamanho de furo, 

pertencentes ao mesmo componente), deve selecionar o componente, clicar com o botão direito e 

selecionar a opção “Find Similar Objects...”, a tela da Fig. 28 surgirá.  
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Figura 28 - Find Similar Objects 

Para selecionar o conjunto de componentes desejado, basta selecionar a característica pela qual deseja 

selecionar os componentes, modificando a situação de Any para Same. A janela da Fig. 29 surgirá. Com 

isso, basta modificar a característica desejada e todos os componentes selecionados serão modificados. 
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Figura 29 - Tela de modificação das características de componentes similares. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

20  

PET - Engenharia Elétrica UFC Março – 2014 
 

PCB de um projeto 

 

 Layers 

Layers são os tipos de camadas com as quais são feitas as ligações dos componentes no PCB. As 

principais layers são: 

 Top Layer: layer de camada superior 

 Bottom Layer: layer de camada inferior 

 Keep-Out Layer: layer de corte 

 

 Regras de PCB 

Podem-se definir regras para o roteamento de modo a facilitá-lo. Dessa forma, acessamos o menu Design, 

opção Rules, Fig. 30. 

 

Figura 30 - Menu Rules 

As principais opções desse menu são:  

 Electrical - Clearence - Clearence: define-se a distância mínima entre as ligações. 

 Routing - Width - Width: define-se o tamanho mínimo, máximo e preferido de cada layer. 

 Plane - Polygon Connect Style – Polygon Connect: modifique para direct connect. 

 

 Roteamento do PCB 

Com o arquivo de PCB criado, Fig. 31, arraste os componentes inseridos na etapa anterior para o centro 

da tela de forma que fique com a melhor visualização possível. As ligações entre os terminais ainda estão 

presentes.  
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Figura 31 - PCB 

Para rotear a placa primeira escolha a Camada Bottom Layer na parte inferior. Com essa camada 

selecionada, clique na opção da Barra de Ferramentas Interactively Route Connections. 

 

Figura 32 - Interactively Route Connections 

O cursor irá tomar um formato de cruz e ao clicar em um terminal de algum dispositivo um círculo será 

formado em torno dele. 

 

Figura 33 - Passo 1 

Arraste o cursor com o botão esquerdo clicado até o próximo terminal. Aparecerá a trilha em AZUL no 

caminho escolhido. Por fim, um círculo também se formará em torno do terminal do segundo dispositivo 

ao se clicar nele. 

 

Figura 34 - Passo 2 
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Figura 35 - Passo 3 

 

Figura 36 - Passo 4 

Repete-se então o processo para todos os outros componentes e ligações, Fig. 37. 

 

Figura 37 - PCB roteado 

Caso se deseje modificar a espessura de uma trilha específica ou a layer a qual pertence, basta dar dois 

cliques na referida trilha e alterar a espessura em Width e modificar o tipo de layer na opção Layer, Fig. 

38. 

 

Figura 38 - Opções de trilha 
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 Malha de Potencial 

Em certos PCB, torna-se difícil realizar as ligações de determinada NET por já existirem muitas ligações 

feitas. Desse modo, utilizam-se as malhas de potenciais. Geralmente utiliza-se malha de potencial para o 

GND. A malha é adicionada através da opção Place Polygon Plane na barra de ferramentas, Fig. 39. 

 

Figura 39 - Place Polygon Plane 

Na tela da Fig. 40, define-se a layer utilizada para a malha e a que NET ela deve ser conectada. Aperte a 

tecla OK e depois, de volta a tela do PCB, desenhe o plano e, ao final, aperte ESC, Fig. 41. 

 

Figura 40 - Polygon Pour 

 

Figura 41 - PCB finalizado 
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Impressão 

 

Para se realizar a impressão do PCB, primeiro deve-se acessar a opção Preview no menu File, Fig. 42. 

 

Figura 42 - Print Preview 

Para preparar o arquivo para impressão, deve-se realizar os seguintes passos: 

 Clique com o botão direito do mouse e acesse Page Setup. Em Scaling, mude para Scaled Print e 

depois para 1. Em Color Set, mude para Mono. Clique em Close, Fig. 43. 

 

Figura 43 - Arquivo de impressão com a escala correta 

 Clique com o botão direito do mouse e acesse o menu Configuration. Marque a opção Holes. 

 Clique com o botão direito nas layers “Top layer” e “Top Overlay” e na opção Properties. 

Marque Hide para todas as opções. Clique em OK e em OK novamente, Fig. 44. 
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Figura 44 - Arquivo para impressão 

Seu arquivo está pronto para impressão. 

 

 Gerber Files 

Quando se trabalho com prototipagem de placas, os equipamento mais utilizados são os fotoploters para a 

formação das imagens da PCI e que pode ser gerado a partir de qualquer programa para projeto de PCI. 

Para isso, são gerados os chamados Gerber Files, onde cada layer é gerada separadamente para 

visualização em programas editores, sem necessitar do programa originalmente utilizado para o projeto da 

placa [MICROPRESS]. 

Para melhores informações sobre como gerar os Gerber Files a partir do Altium, acesse: 

http://micropress.com.br//application/assets/files/gerando-gerber-no-altium-designer.pdf 

 

http://micropress.com.br/application/assets/files/gerando-gerber-no-altium-designer.pdf

